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Needed during practice

= 01 _EFM32 User guide_efm32gg-stk3700-
user_guide.pdf

" 02 _EFM32_Schematic_ EFM32GG-BRD2200A-A03-
schematic.pdf

= 03 _EFM32_Reference_manual EFM32GG-
reference_manual.pdf

= 04 EFM32_Datasheet efm32gg990 datasheet.pdf
" Terminal program
Difference between datasheet and user guide:

-Reference manual contains general info of the whole IC family

-Datasheet contains specific info of a certain type of IC
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UART / USRT / USART

= UART or USRT or USART?

O UART: Universal Asynchronous Receiver/Transmitter
e Serial communication without application of CLK line

O USRT: Universal Synchronous Receiver/Transmitter
e Serial communication based on CLK signal
O USART: Universal Synchronous Asynchronous
Receiver/Transmitter

 Since the operation is very similar (main difference is the CLK
signal) sometimes both are discussed without distinction
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UART properties

= No CLK signal, i.e., CLK line not needed->less wire
= 2 data lines: transmitter (Tx) and receiver (Rx) line
= Communication speed (=bit duration) has to be

set -> defines the bit borders in the system

O Reference oscillators at both the Tx and Rx sides has to
be precise otherwise frequency difference will occur
between Tx and Rx side and bit duration will change

O If CLK existed it would define the bit borders (as done
in USRT)
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UART Communications

= Start of communications: edge change from H->L
for 1 bit duration Sop or idle

O Start of frame bit (Start bit . ata Bi
‘ ) s s W owasi

0 Used for synchronization
= Data bits: from 4 up to 16 data bits
= Parity bit (P): optional

O Used for error detection->error is not corrected

Bit border

O Even parity: count of 1-bits is even->P=0, otherwise
P=1

0 Odd parity: count of 1-bits is odd->P=0, otherwise P=1
" End of communications: edge change from L->H
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UART Communications

" End of communications: line is High for 1 or 1.5 or
2 bit duration ity B Sart or idle

. ’ STOP Bit
Data Bit —‘>[B] [F] / Stop \ (High)

= Full frame:

’4 Frame ﬂ

Stop or idle Start or idle

RO O0 000000 CERN

Refer to page 451 of 03_EFM32_Reference_manual_EFM32GG-reference_manual.pdf
(Full USART: pp. 449-495)
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UART connection

" Checking the datasheet (for IC specific info) is a
must -> see page 13.

7 Board Controller

The kit contains a board controller that is responsible for performing various board level tasks, such
as handling the debugger and the Advanced Energy Monitor. An interface is provided between the
EFM32 and the board controller in the form of a UART connection. The connection is enabled by setting
the EFM_BC_EN (PF7) line high, and using the lines EFM_BC_TX (PEO) and EFM_BC_RX (PE1) for
communicating.

Specific library functions has been provided in the kit Board Support Package that supports various
requests to be made to the board controller, such as quering AEM voltage or current. To use these
functions, the Board Support Package must be installed. See the Chapter 8 to find out more.

Note
The board controller is only available when USB power is connected.

Refer to page 13 of 01_EFM32_User_guide _efm32gg-stk3700-user_guide.pdf
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UART connection

= Also see page 14.

8 Board Support Package

The Board Support Package (BSP) is a set of C source and header files that enables easy access to,
and control over some board specific features.

Compared to the Energy Micro development kit, the functionality is limited. Unless you need/want some
of the functions contained in the BSP, there is really no need to include or use it. The EFM32 in the Starter
Kit is fully usable without BSP support, and you can use all peripherals in the emlib without the BSP.

The BSP use EFM32 peripheral UARTO, Location 1 (TX pin PEO, RX pin PE1) on baudrate 115200-8-
N-1 to communicate with the board controller.

Note

The BSP is only functional when the Starter Kit is USB-powered, using these function calls
with USB disconnected will give unpredictable results.

Refer to page 14 of 01_EFM32_User_guide _efm32gg-stk3700-user_guide.pdf
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UART connection on uC

= Checking the schematic

. . MCU_PE[15..0] 1 pe—
Port E (PE) connections: FE3.00 | eu e LamTe Tres
WMCU_FET UARTU FAE })EFM_EC_T?C_
« EFM_BC_RX
Port F (PF) connections: MCU_PF1Z.5] ¥ o -
MCU_PFT
s P S EFM BC EM
. W3 VMCU VMELU_SWITCHED
Enabling UART: A A TA
? 2 BC_UART_TX
USS0A
UBDZA T5344751 o
EFM_BC_RX /\{ i COM1 == NO1 :13
EFM_BC TX g CoM2 — — NOZ [ &HD
6] COM3 —— NO3 [y
RE12 [] COM4 — = ND4
10K “5!‘ IN1 5 3 FBC_UART_RX
IN2
13 e UGE0E
IN4 -
EFM_BC_EN > GMND
Isolation Level Shifting
RE11 RE1D
180K 10M

GND GND
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UART connection — Board Controller

Froduction test:
10MHz reference
clock input

TPJ812

]

Board Controller:

LED_JLINK
LED_DEBUG_OUT Ueoos

X7 PDO/OSC_IN { FSMC_D2 [CANRX,
#—g7| PD1/0SC_OUT / FSM |:_|:|[ 3 jCAN'I]'k']
=7 PD2/TIM3_ETR/UART5_RX / SDIO_CMD
¥—g7 | PD3/FSMC_CLK [USART2_CTS]
¥—pgr| PD4/FSMC_NOE [USARTZ_RTS]
BC_UART_TX 5| PD5 ! FSMC_NWE [USARTZ_TX]
BC_UART_RX On | PDB { FSMC_NWAIT [USART2_RX]
¥—jrg| PD7 /FSMC_NE1 / FSMC_NCE2 [USART2_CK]
BC_MCURST_CON T PD8/FSMC D13 [USART3_TX]
75| PD8/FSMC_D14 [USART3_RX]
¥—p—| PD104 FSMC_D15 [USARTE_CK]
BC_UIF_PBO %io | PD11/FSMC_A18 [USART3_CTS]
BC_UIF_PB1 T{f| PD124 FSMC_A17 [USARTI_RTS/ TIM4_CH1]
BC_UIF_PBi_CON ) HiT| PD13 4/ FSMC_A18 [TIM4_CH2]
BC_UIF_PED_CON I &ig| PD14/ FSMC_D0 [TIM4_TH3)
BC_UIF_MCURST e PD15{ FSMC_D1 [TIM4_CH4]
ﬁtﬁﬂ” 2: PED f TIM4_ETR { FSMC_NBLO
FIREEL A7 | PE1/FSME_NBL1
BOARD REVO g3 | PE2/ TRACECK [ FSMC_A23
<7 _/EOARD_REVI 1| PE3/ TRACEDO / FSMC_A18
anD = 05| PE4/ TRACED1 / FSMC_A20
¥—p5| PES/ TRACED2 / FSMC_A21
TPJ14% A5 | PEG I TRACEDS / FSMC_A22
~ 75| PE7 / FSMC_D4 [TIM1_ETR]
X5 PES/FSMC_D5 [TIM1_CHIN
GND | <55 PES I FSMC_D6 [TIM1_CH1 i
PE10 / FSMC_DT [TIM1_CH2N]
PE11/FSMC_DE [TIM1_CH2]
PE12 / FSMC_DO [TIM1_CH3N]
PE13 / FSMC_D10 [TIMT_CH3]
PE14 / FSMC_D11 [TIM1_CH4]
PE15 / FSMC_D12 [TIM1_BKIN]

Control MCU

> AEM_CTRL[3..0]

ROTE 4KT NM
BOARD_REVD —
e

REIT 4KT NM

BOARD_REWV1 —
BOA RD.RE"."[' 0] L]
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UART connection — Board Controller

Board Controller:

DEBUG_#TRST_OUT 4 3
DEBUG_TDI_OUT
DEBUG_TMS_SWDIO_OUT Lg00A Centrol MCU
DEBUG_TCK_SWCLK_OUT “TRST OUT 62
DEBUG_STRST_IN TOT 00T Fi5-| PAQ / WKUP [ USART2_CTS / ADC123_IND / TIM2Z_CH1_ETR / TIM5_CH1 / TIM8_ETR
DEBUG_TDLIN e 7| FA11USART2_RTS [ ADC123_IN1 I TIM5_CH2 J TIM2_CH2
DEBUG_TMS_SWDIC_IN o {5| PAZ | USARTZ_TX | ADC123_IN2J TIM5_CH3 / TIMZ_CH3
DEBUG_TCK_SWCLK_IN —— 55| PA3  USARTZ_RX J ADC123_IN3J TIMS_CH4  TIMZ_CH4 PORT A
DEBUG_#RESET_IN e T3] PA% 1 SPI1_NSS | DAC_OUTT / USARTZ_CK / ADC1Z IN4
DEBUG_TDO_SWO_IN e 5| PAS I SPI1_SCK / DAC_OUT2/ ADC12_IN5
= 75| PAB i SPI1_MISO / TIME_BKIN [ ADC1Z_ING { TIM3_CH1 [TIM1_BKIN]
s PA7 | SPI1_MOSI { TIMB_CH1N / ADC1Z_IN7 / TIM3_CH2 [TIMT_CH1N
REQT 1KS FRESETIN B8 PAB | USART1_CK I TIMT_CHITMCO — ~CRzh_cR
D Ro0Z 7R e OO SWo TR 570 | PAS / USART1_TX/ TIM1_CH2
== 70| PA10/ USARTT_RX { TIMT_CH3
us&DM%:E 10 | PA11/USARTI_CTS / CANRX / TIM1_CH4/ USBEDM
USBDP 21| PA12 /USART1_RTS / CANTX [ TIM1 _ETR / USBDP
- A FA13 1 JTMS-SWDIO
ce00 oot 37| FA14/JTCK-SWCLK
o . PA15 [ JTDI
fee 8P DEBUG_EXT VDD_TARGET 1 PBO/ADC1Z_INS S TIM3_CH3 / TIMS_CH2N
DEBUG_EXT CABLE ATTACH 3 &5 PB1/ADC12_ING | TIM3_CH4 / TIME_CH3N FORT B
an AEM_VMCU_ENABLE -} 27| FB21BOOTI

A | FB31JTDO T TRACESWO JSPI3_SCK /I253_CK [TIMZ_CH2 [ 5P11_SCK]
PB4 / JNTRST ! SPIZ_MISO [TIMI_CH2 ! SPIT_MISO)

DEBUG_BUF_2OE &2 PBS /2C1_SMBALI SPI3_MOSI / 253_SD [TIM3_CH2 f SPI1_MOSI]
DEBUG_TMS_SWDIO_#0E A% | FEBJ12C1_SCL/ TIM4_CH1 [USART1_TX]
DEBUG_MCU_ISOLATE $EN g4| PE7 {12C1_SDA/ FSMC_NADV ] TIM4_CH2 [USART1_RX]
DEBUG_#RESET 2| PBBJ TIM4_CH3 / SDIO_D4 [12C1_SCL/ CANRX]

EEPROM_WP J7 | FB8 I TIM4_CH4 / 5DID_D5 [l2C1_SDA/ CANTX ]
§ K7 | PE10/I12C2_SCL f USART3_TX [TIM2_CH3]
5 kg | FB11 112C2_SDA | USARTI_RX [TIMZ_CH4]
6] PB12/SPI2_NSS / 1252_WS/12C2_SMBAI | USART3I_CK / TIM1_BKIN

CTRLMCU_I2

CTRLMGU_SPL HE—| PB13/ SPIZ_SCK/1252_CK / USART3_CTS / TIM1_CHIN
CTRLMCU_SPIMISO 3 =5| PE14 1 SPLZTMISO / TIMT_CHIN { USART3_RTS
CTRLMCU_ SPL_MOSI %2 PE15 / SPIZ_MOSI { 1252 5D / TIM1_CH3N
AEM_SENSE_VOLTAGE £ Peosapciza_nto
AEM_SENSE_CURRENT_RANGE1 £5-| PC1/ADC123 IN11 PORT C

AEM_SENSE_CURRENT_RANGEZ £3 | PC2/ADC123_IN12
ENSE &4 | PC2/ADC123_IN13

7| PC4/ADC12_{N14
C Fig—| FC5/ADG12_IN15
DEBUG_DH_3W_ENABLE ET5| PC6/ 1252 MCK / TIMB_CH?1 / SDIO_DS [TIM3_CH1]
DEBUG_MCU_SW_ENABLE 5| PC7/1253_MCK { TIMB_CH2 / SDIO_D7 [TIM3_CHZ]
o PCE/ TIME_CHZ / SDIO_DO [TIM3_CH3]
pac0 TRIRZE o00 T 4| PCo/ TIMB_CH# / SDID_D1 [TIM3_CH4]
1 ? Trae01 & 55| PC10/ UART4_TX/ SDID_D2 [USART3_TX]
A-EE CTRL MCU #TRST TRJE02 o} =5 PC11/ UART4_RX / SDIO_D3 [USARTI_RX]
z CTRCMCO-TOT O J5-| PC12/ UARTS TX / SDID_CK [USARTI_CK]
el [ TTRL_NCU_THS_SWDIg TRiei0 © A1_| PC13J TAMPER-RTC
0 ] TTRL_NMCU_TCK_SWCL TPIe11 @ 7| PC14/0SC32_IN
12 H PC15/ 05C32_OUT
1 CTRL_MCU_TDO_SW|
16 | u g 115 ey pr—
1 = % CTRLMCU_DEBUG_$RESET
20 [ = 1]
PR
N
GHD BOOTLOADER_HALT [ >l
CTRLMCU_STATUS R
LED_STATUS R 8 CIRLMUU _STAITUS B

LED_STATUS_G
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UART connection — USB PHY

USB:
. L
PC via USB cable
12345
2 ooooo g
] T Place these TEs
close to U5
TPJE04 header
= |0 € = sV
— 0
TPJBD3
:; *_»I..: L8000
GMND GND GMND T CBF221HC
1 v 2
-y USBDP
+ = USBDM
l g 5 kS
D&0no
o]
TPJBD1 TPJB02 IP4220CZ8 ;i i %;
1 2 d
GMND
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UART connection — Block diagram

Board Controller

USB_DATA+

varTsuse [ | USBCABLETORC

USB_DATA-

RX (PE1)
UARTo TX (PE0)

EN (PF7)

PC
>_ Terminal program

USB CABLE TO PC SW-based UART
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

==+ New Silicon Labs Project O X
Project setup ﬁ
Select the board, part, and SDK for the project.
Boards:
Search ‘ A4

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev AD3) *

Part:

| Search ‘ ™

| EFM32GG990F1024 |

SDK:
|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel V| (7]

Manage SDKs...

@ < Back Finish Cancel
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

== New Silicon Labs Project O X
Project setup @
Select the board, part, and SDK for the project.
Boards:
Search | w

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev A03) *

Part:

| Search | W

| EFM32GG990F1024 |

SDK:

|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel

Manage SDKs...

@ < Back Finish Cancel

© BME-MIT

«= New Silicon Labs Project O X
Project setup E
Select the type of project.
Project Type:

@ Empty C Program - Create an empty C executable project.

(O Empty C++ Program - Create an empty C++ executable project.
(O Example - Create a working example for the part.

(O Library - Create an empty static library project.

(O Simplicity Configurator Program - Create a project whose contents are driven from
Simplicity Configurator.

@ < Back Finish Cancel
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Strating with a new project

= Give project name and location, and set
Copy content:

«== New Silicon Labs Project O X
Project Configuration @
Select the project name and location.

Project name: | UART_COM ‘

Use default location
CA\Users\krebesz\SimplicityStudio\v4_workspace\UART_COM Browse...
With project files:
(O Link to sources
(O Link sdk and copy project sources
(@ Copy contents

@ < Back Mext = Cancel
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Project created — start programming

"= Main.c can be also renamed to UART_COM.c

= Although an empty C project has been created a
program skeleton is offered automaticly

[5 Project Explorer &2 =% < = 0O || UART_COM.c &3
(£5 STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - (] 1 #include "em device.h"
(25 STK3700 button [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 é #include "em chip.h"
v &5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gec|| =~ _ _
: 4=int main (void)
kit Includes 5 1
= CMSIS o /* Chip errata */
= emlib 7 CHIP Init():
v [ SIC a
lel UART_COM.c G /* Infinite loop */
10  while (1) {
11}

12 }

4
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CLK for GPIO peripheral (CMU system)

= Every peripheral has and needs a CLK to operate

CMU_HFPERCLKDIV HFPERCLKEN

HFXO
Timeout f————p»

I

CMU_CTRL.HFCLKDIV

| clock HFCLK

vy

HFRCO

Refer to page 128 of

03 _EFM32_Reference_manual _EFM32GG-reference_manual.pdf

switch DIV
Timeout
CMU_CMD HFCLK

© BME-MIT

)7 prescaler

HFPERCLK

CMU_HFPERCLKEMNO.TIMER0) ——

Clock
Gate

CMU_HFPERCLKEMO.TIMERT ———

Clock
Gate

CMU_HFPERCLKDIV.HFPERCLKDIV

CMU_HFPERCLKENO0.12C0 —

Clock
Gate

Clock
Gate

Méréstechnika és
Informaciés Rendszerek

HFPERCLKTIMERD

HFPERCLKI2¢co

HFCORECLKcM3
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CLK for GPIO peripheral

" CLK for GPIO peripheral must be enabled
= Search the library where Simplicity Studio is
installed

O Contains include (inc: *.c) and source (src: *.h) files:
i:\Simplicity _studio\developer\sdks\gecko sdk_suite\v2.6\platform\emlib\

" Following files has to be drag-and-dropped into
emlib library of the project (see next slide):
0 em_cmu.c (clock management unit)
O em_gpio.cC

O em_usart.c

. Méréstechnika és .
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CLK for GPIO peripheral

* Furthermore they have to be included into the
program:

[?5 Project Explorer 2 g ¥ = O EI *UJART_COM.c
(5 STK2700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - ( 1 #lnGlUdE device.h"
5 STK2700_button [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 2 .

w 5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gec

kit Includes
= CMSIS

(~ = emlib \ 7

—> > g em_cmu.c 8

Ml

#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"

~int main (void)

—3» > [¢ em_gpio.c

lg| em_system.c { /% chi ,
— /* Chip errata *;
rt. .
tE?@ ST J CHIP Init();
v [= SIC —
<l UART_COM.c /* Infinite loop */
while (1) {]
}
}

- Check how the CLK for GPIO can be enabled:

Mér hnik .
© BME-MIT M Ini?o‘rer?'\t:cclés Raeremjszerek ZOS“de

Tanszék




CLK for GPIO peripheral (check .h files)

" |n programming window click on
em_device.h and press F3 -> em_device.h opens

= Defines for different processors from EFM32
family are found -> search for your own type
(EFM3266990F1024) @_lufum_r:om.c 7 em_deviceh

fellr delfined(bLEMsAGLYd4AE1ULG )
145 $#include "efm32gg9%42£f1024_h"
1459
150 #elif defined (EFM32GG9%42F512)
151 #include "efm32gg%42f512.h"
152
153 $#elif defined (EFM32GG%80F1024)
154 $#include "efm32ggS%80£1024.hH"

156 #elif defined (EFM32GG9%80F512)
157 #include "efm32gg%80£512.h"

kM telif defined (EFM32GG990F1024)
il include "efm32gg990£1024.h"

- Méré hnika é .
© BME-MIT M Ini?orer?'!t:cciés Raereészerek 215||de

Tanszé k




CLK for GPIO peripheral (check .h files)

= Click on EFM32GG990F1024.h and press F3
" EFM32GG990F1024.h contains (among others)

O IT number that belongs to a certain peripheral

60 /xxEEEE EFM32G Peripheral _nte::upt P
7L DMA IRCn a, '< 0 EFM32 DMA Interrupt */

71 GPID EVEN IRQI]
72 TII'-ERD ITRONn

1, EW!{ 1 EFM32 GPIC EVEN Interrupt */
2, J/*!< 2 EFM32 TIMERO Interrupt */

O Memory addresses, e.g. base addresses

359 f#define CMU BASE {0x400CB8000UL) /**< CMU base address */
360 #define GPIC BASE (0x40006000UL) /**< GPIC base address */

* No need to check reference manual for e.g. base addresses

— Refer to page 17 of
03_EFM32_Reference_manual _EFM32GG-reference_manual.pdf to
base addresses

- Méré hnika é .
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CLK for GPIO peripheral (check .h files)

O Defines types that are pointers for the base address

410 #define CMU ((CMU TypeDef *) CMU BASE) /*%< CMU base pointer *
411 $#define GPIC ((GPIO TypeDef *) GPIO BASE) /*%< GPIO base pointer *

e Click on (CMU_TypeDef *) and press F3

— Type definitio
structure

f CMU pops-up in efm32gg_cmu.h which is a

— Elegant solution

!
0x400e04
0x400€0000 s A
typedef struct { o000 — PTS
. 0x400cad00
__IOM uint32_t CTRL; Ox400ca000 RMU
. (0x400c8400
__IOM uint32_t HFCORECLKDIV; Ond00CE000 —tem
0x400cs400
0x400c6000 < =Y
e offset register addw%isters base address.
N
} CMU_TypeDeT; N k/
- 0x000 CI\RI_CTRL RW CMU Control Register
0x004 CMU_HFCORECLKDIV RW High Frequency Core Clock Division Register

Elements of structure is assigned to the memory registers via base-address pointer!
. |'|-|_|j- iormscos Renaezere 23.5lidle




CLK for GPIO peripheral (check .h files)

In the header file:

In the RM see p.136
.

(03_EFM32_Reference_manual

EFM32GG-reference_manual.pdf):

E;EEE;? struct |
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IM uint32 t
__IM uint32 t
__IOM uint3Z t
__IOM uint3Z t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
uint3z t
__IM uint32 t
__IOM uint32 t
__IOM uint32 t
uint3z t
__IOM uint32 t

uint3z t

__IOM uint32 t
uint32 t

__IOM uint32 t
uint32 t

__IOM uint32 t
__IOM uint32 t
__IOM uint32 t
__IOM uint32 t

} CMU TypeDef;

-

CTRL;

—— T e =T

HECORECLEDIV;

HEPERCLEDIV;
HERCOCTRL;
LEFRCOCTRL;
AUXHFRCOCTRL;
CALCTRL;
CALCNT;
OSCENCMD;
CMD;
LFCLESEL;
STATUS;

IF:

IFS;

IFC;

IEN;
HFCCRECLKENO;
HFPERCLEKEN(;
RESERVEDO [2U] ;
SYNCBUSY;
FREEZE;
LFRCLEEND;
RESERVED1[1U];
LFBCLEENO;

RESERVEDZ [1U] ;
LFAPRESCO;
RESERVED3[1U] ;
LFBPRESCO;
RESERVED4 [1U] ;
PCNTCTRL;
LCDCTRL;
ROUTE;

LOCK;

I e A S S S S S S S S M T M I M W R

W

[

i
/9

I |

———
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RW CMU Control Register
0x004 > CMU_HFCORECLKDIV RW High Frequency Caore Clock Division Register
fxdtE— | CMU_HFPERCLKDIV RW High Frequency Peripheral Clock Division Register
0x00C CMU_HFRCOCTRL RW HFRCO Control Register
0x010 CMU_LFRCOCTRL RW LFRCO Control Register
0x014 CMU_AUXHFRCOCTRL RW ALUXHFRCO Control Register
0x018 CMU_CALCTRL RW Calibration Control Register
0x01C CMU_CALCNT RWH Calibration Counfer Register
0x020 CMU_OSCEMCMD Wi Oscillator Enable/Disable Command Register
0x024 CMU_CMD Wi1 Command Register
0x028 CMU_LFCLKSEL RW Low Freqguency Clock Select Register
0x02C CMU_STATUS R Status Register
0x030 CMU_IF R Interrupt Flag Register
0x034 CMU_IFS W1 Interrupt Flag Set Register
0x038 CMU_IFC W1 Interrupt Flag Clear Register
0x03C CMU_IEN RW Interrupt Enable Register
0x040 CMU_HFCORECLKEMNO RW High Frequency Core Clock Enable Register 0
0x044 CMU_HFPERCLKEND RW High Frequency Peripheral Clock Enable Register 0
0x050 CMU_SYMCBUSY R Synchronization Busy Register
0x054 CMU_FREEZE RW Freeze Register
0x058 CMU_LFACLKEMD RW Low Frequency A Clock Enable Register 0 (Async Reg)
0x060 CMU_LFBCLKEMOD RW Low Frequency B Clock Enable Register 0 (Async Reg)
0x068 CMU_LFAPRESCD RW Low Freqguency A Prescaler Register 0 (Async Reg)
0x070 CMU_LFBPRESCD RW Low Freguency B Prescaler Register 0 (Async Reqg)
0x078 CMU_PCNTCTRL RW PCNT Control Register
0x07C CMU_LCDCTRL RW LCD Control Register
0x080 CMU_ROUTE RW I/ Routing Register
0x084 CMU_LOCK RW Configuration Lock Register
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CLK for GPIO peripheral

= Using the structure CMU

O CMU is a structure pointer: arrow is used ->

0 CMU-> (Ctrl+Space will complement)
e Needed: HFPERCLKENO (Bit 13 is used for GP1O CLK)

11.5.18 CMU_HFPERCLKENO - High Frequency Peripheral Clock Enable

Rengtero See ref.man. P150:

004|518 R|R|N(QIL|IIR|N|s | RIZe(=|ele|z ez |e|o|o|r|ojw || a| |0

Reset o|lo|lo|lo|olo|lo|lo|o|o|o|ojlo|o|jo|o |o|o

Name SSM%QPQEEEEEgl‘:EE":E
|- |FIF o2 |>

* A define is available for Bit 13 in efm32gg cmu.h

919 #define CMU HFPERCLKEN(O GPIO (0x1UL << 13)
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CLK for GPIO peripheral (CMU system)

= Every peripheral has and needs a CLK to operate

ocC

Y

CMU_HFPERCLKEMNO.TIMER0) ——

CMU_HFPERCLKDIV HFPERCLKRN HFPERCLK
presca ler
C LKDIV

CMU_CTRL.HFCLKDIV

HFXO

_\—b Timeout f————p» |
| clock HFCLK
switch piv [ [HFCLK
HFRCO _,—b Timeout
CMU_CMD HFCLK

Refer to page 128 of

Clock HFPERCLKTIMERD >
Gate
CMU_HFPERCLKENO . TIMERT ——— Clock HFPERCLKTIMER!
Gate
HFPERCLKEN 1 Clock HFPERCLK/2c0
Gate
EMO ——
Clock HFCORECLKcM3 >
Gate

03_EFM32_Reference_manual _EFM32GG-reference_manual.pdf

= Code to be used:

© BME-MIT

O CMU->HFPERCLKENO |= CMU_HFPERCLKENO_GPIO;
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Setting GPIO in code (enable)

= Remember: PF7=1 has to be set

= More elegant approach if a function can be found
for a problem -> Results in more readable code

O Check functions under em_gpio.c in the project

{5 Project Explorer & S-S
~ = emlib
lg em_cmu.c
v [€ em_gpio.c
o em_gpio.h
# GPIO_DRIVEMODE_VALID(
# GPIO_STRENGTH_VALID()
@ GPIO_DbglocationSet{unsigned int) : void
@ GPIO_DriveModeSet(GPIO_Port_TypeDef, GPIO_DriveMode_TypeDef) : void
& GPIO_DriveStrengthSet(GPIO_Port_TypeDef, GPIO_DriveStrength_TypeDef) : void
@ GPIO_EM4EnablePinWakeup{uint32_t, uint32_t) : void
2@ GPIO_ExtintConfig(GPIO_Port_TypeDef, unsigned int, unsigned int, bool, bool, bool) : void
2 GPIO_PinModeGet(GPIO_Port_TypeDef, unsigned int) : GPIO_Mode_TypeDef

2 GPIO_PinModeSet(GPIO_Port_TypeDef, unsigned int, GPIO_Mode_TypeDef, unsigned int) : void
le) em_system.c

[g em_usart.c
w2 SIC
lg UART_COM.c
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Setting GPIO in code (enable)
= Open (double click on) GPIO_PinModeSet

O em_gpio.c opens at the function implementation

O Remark: em_gpio.h also contains the definition of
functions and even more, e.g. static functions available
only in header files

O Note: these functions are independent of the type of
processor, since the processor dependent specialities
are defined in efm32gg xxx.h

* Helps to develop portable code that is compatible with other
processors (from the same processor family at least)

O Hint: copy the function and paste it into code; make it
one-line; comment the orig. and make a work copy

e . Méréstechnika és .
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Setting GPIO in code (enable)

= Read the function description: placed above the
function definition

* @brief
Set the mode for a GPIO pin.

* @param[in] port

The GPIO port to access.

* Bparam[in] pin

%
x
%
x
%
x
* The pin number in the port.
N
%
x
%
x
%
x

* @Bparam[in] mode

The desired pin mode.

* @param[in] out
' B value to set for the pin in the DOUT register. The DOUT setting is important for
some input mode configurations to determine the pull-up/down direction.
void GPIO_PinModeSet (GPIC Port TypeDef port,
unsigned int pin,
GPIO Mode TypeDef mode,
unsigned int out)
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Setting GPIO in code (enable)

= Function to be used:
O GPIO_Port_TypeDef + F3

/*% GPIO ports
typedef enum |

IDs. */

$if ( GPIO PORT A PIN COUNT

gpioPorta = 0,
fendif

$if ( GPIO PORT B PIN COUNT

gplioPortB = 1,
$endif

$if ( GPIO PORT

gploPortc = 2,
fendif

§if ( GPIO PORT

gplioPortD = 3,
$endif

$if ( GPIO PORT

gpioPortE = 4,
fendif

gpiEPorfF = 5,

C_PIN COUNT

D PIN COUNT

E_PIN COUNT

COUNT

void GPIO_ PinModeSet (GPIC Port TypeDef port,

endl

} GPIO Port TypeDef;

© BME-MIT

v

unsigned int pin,
GPIO Mode TypeDef mode,
unsigned int out);

Use the names given in
the enum type definition

. Méréstechnika és .
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Setting GPIO in code (enable)

u Funct|on to be used' void GPIO_PinModeSet (GPIO Port TypeDef port,

unsigned int pin,
GPIO Mode TypeDef mode,

O pin — port number, now it is 7 unsigned Int out);

* No specific name is given
0 GPIO_Mode TypeDef + F3

typedef enum |
/** Input disabled. Pull-up if DOUT is set. */

gpioModeDisabled = GPIO P MODEL MODE( DISABLED,
/*% Input enabled. Filter if DOUT is set. */

gpioModeInput = GPIO P MODEL MODE0 INPUT,

/*% Input enabled. DOUT determines pull direction. */

gpioModeInputPull = GPIO P MODEL MODE( INPUTPULL,

/*% Input enabled with filter. DOUT determines pull direction. */
gpioModeInputPullFilter = GPIOC P MODEL MODE D_INPUTPULLFI LTEE,
/ k& Db Quibnit L

gpioModePushPull — = GPIO P MODEL MODE( PUSHPULL,

Use the names given in

0 out — initial value of pin, use 1 the enum type definition
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Setting the UART (CLK)

= CLK is needed again!

O Already used approach is also possible: setting CMU
register

O Better way is using a function for that purpose
e Check em_cmu.cin the project by unfolding it:

[+ Project Explorer &2
* Find CMU_ClockEnable among functions v el
w em_cmu.c
e Copy the function and paste it into the code: U em_asserth
= em_bus.h
= em_cmu.h
CMU_ClockEnable(CMU _Clock_TypeDef clock, bool enable); o em cmuh
— enable — it should be true obviously o em_commonh

— CMU_Clock_TypeDef + F3
» cmuClock_UARTO should be used

O Code to be used:
CMU_ClockEnable(cmuClock_UARTO, true);

éréstechnika és .
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Setting the UART (Tx and Rx)

= Remember: port settings for communications
O PEO = Tx -> PEO is output
O PE1is Rx->PE1 is input

= Use the function GPIO_PinModeSet again

O GPIO_PinModeSet(gpioPortF, 7,gpioModePushPull, 1),
e Used for setting PF7 into 1 to enable the UART comm.

0 GPIO_PinModeSet(gpioPortE,0,gpioModePushPull, 1),
e See changes in red for setting Tx line (PEO is now output)

0 GPIO_PinModeSet(gpioPortE,1,gpioModelnput,1);
e See changes in red for setting Rx line (PEYis now input

Delete back until gpioMode, then push F3 This boolean is don’t care now
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Configuration of the UART

" Check em usart.cin project explorer  [-eoieceioe =

v (= emlib
O Find USART _InitAsync and double click o o
lg] em_system.c

e em_usart.c opens at the function implement.

v [€ em_usart.c
= em_assert.h

e Read description of the function 21 em bush

= em_cmu.h

e Copy the function and paste it into the code
— USART _InitAsync(USART_TypeDef *usart, const USART _InitAsync_TypeDef *init)

= USART InitAsync()

O USART_TypeDef + F3 : it is a structure again defined in
efm32gg usart.h

e Remember that a pointer is used here!
— check out for its define in efm32gg990F1024.h

. Méréstechnika és .
© BME-MIT Informaciés Rendszerek 34S||de
Tanszék



Configuration of the UART

— Define of USART_TypeDef in efm32gg990F1024.h

398 $#define USARTD ( (USERT TypeDef *) USERT(O BASE) /**< USRRT0O base pointer */
399 #define USARTL ((USERT TypeDef *) USERT1 BASE) /**< USART1 base polnter */
400 #define USRRTZ ( (USERT TypeDef *) USERTZ BASE) TR L‘SEARTE base p-::uinte: x/
401 #define URRTO ((USART TypeDef *) UARTO BASE) /*%*< URRT0O base polnter */
102 $define URRTI ( (USARRT TypeDef *) URRT1 BASE) /*%< URRT1 base pointer */

— More than only one USART is available: USARTO is our choice
(& is not needed since it is a pointer: see later)

O USART _InitAsync_TypeDef + F3

* Important parameters for the USART

e Unfortunately this structure is not existing, therefore it has
to be implemented

— implementation is advised before the main function in the .c main
file as a global variable. In this case its initial value becomes zero
while when implementation is done inside the main function it fills
up the structure with memory garbage

— USART_InitAsync_TypeDef UARTO_init; * 'tcanbeanyname

* Not UARTO _init is used but a memory address: &UARTO _init
i © BME-MIT rhj_l' Informacios Renaszerek  35.slide
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Configuration of the UART

* Function to be used in the code:
USART _InitAsync(UARTO, &UARTO init);

e UARTO_init structure has to be uploaded with values
— USART _InitAsync_TypeDef + F3 again -> em_usart.h
» Stay above the writing and options pop-up

/** Asynchronous mode initialization structure. */

typedef struct |

/*% Specifies whether TX and/or R¥X is enabled when initialization is completed.
USART Enable TybeDef enable;

/%% Disable both receiver and transmitter. */ S
usartDisable = 0x0, )

baud rate setup.
Enable receiver only, transmitter disabled. */  F[lock.
usartEnableRx = USBRRT CMD RXEN,

lln' + 4

/** Enable transmitter only, receiver disabled. */

usartEnableTx = USRRT CMD TXEN,

—— ey receiver and transmitter. */
usartEnable USART CMD RXEN | USART CMD TXEN)

} USART Enable TypeDef;

1 lln'

PR =

— Code to be used: UARTO init. enable\JsartEnabIe
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Configuration of the UART

e Same way all the other properties has to be filled up

* |nitialization has to be done before using it

//CMU ClockEnable (CMU Clock TypeDef clock, bool enable);
CMU ClockEnable (cmuClock UARTO, true);

URRTO init.enable = usartEnable;
UARTO init.refFreq = 0;

UARTO init.baudrate = 115200;

UARTO init.oversampling = usartOvsleé;
URRTO init.databits = usartDatabitsé;
URRTO init.parity = usartNoParity;
UARTO init.stopbits = usartStopbitsl;
URARTO init.mvdis = false;

UARTO init.prsRxEnable = false;

UARTO init.autoCsEnable = false;
//USERT InitAsync (USART TypeDef *usart, const USART InitAsync TypeDef *init)
USART InitAsync (UARTO0, &URRTO init);

* Note: every name has to checked!
-> e.g. usartDatabits8 is not equal value 8 but value 5
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Configuration of the UART

O Oversampling: see ref.man. page 458:

For oversampling modes 16, 8 and 6, every bit in the incoming frame is sampled three times to gain
a level of noise immunity. These samples are aimed at the middle of the bit-periods, as visualized in
Figure 17.5 (p. 458) . With OVS=0 in USARTn_CTRL, the start and data bits are thus sampled at
locations 8, 9 and 10 in the figure, locations 4, 5 and 6 for OVS=1 and locations 3, 4, and 5 for OVS=2.
The value of a sampled bit is determined by majority vote. If two or more of the three bit-samples are
high, the resulting bit value is high. If the majority is low, the resulting bit value is low.

Maijority vote is used for all oversampling modes except 4x oversampling. In this mode, a single sample
is taken at position 3 as shown in Figure 17.5 (p. 458) .

Majority vote can be disabled by setting MVDIS in USARTn_CTRL.

If the value of the start bit is found to be high, the reception of the frame is aborted, filtering out false
start bits possibly generated by noise on the input.

Figure 17.5. USART Sampling of Start and Data Bits

Idle N Start bit / Bit 0

o A A A A AR Ak
neo H H H ! ! H I H H H H ! I 1 I I } I I ! 1 1 H 1 1 1 1
g. H Il""."|: H H - H H H H H - H H H H H H H H H H | | | H H H
0 0012 3 456 7 8 910111213141516 1 2 3 4 5 6 7 8 9 10 11 12 13
- A A A A A A A A \
" ' ! : | :
g f——>| ! ! ! ! ]
0 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7
~ A A A A A A A A
1] 1 1 : : :
¢ fe——> | | | ' :
0 1 2 3 4 5 6 1 2 3 4 5
o A A A
© 1 2 3 4 1 2 3 4
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Configuration of the UART

= The faster way

O Look for the USART _InitAsync_TypeDef structure (F3)
and scroll down in em_usart.h to find

#define USART INITASYNC DEFAULT \
{ \
usartEnable, /* Enable RX/TX when initialization is complete. */ Y,
0, /* Use current configured reference clock for configuring baud rate. */ \
115200, /* 115200 bits/s. */ \
usartovsle, /* léx oversampling. */ \
usartDatabitss, /* B data bits. */ Y,
usartNoParity, /* No parity. */ \
usartStopbitsl, /* 1 stop bit. */ \
false, /* Do not disable majority wvote. */ \
false, /* Not USERT PRS input mode. */ \
0, /* PRS channel 0. */ Y,
false, /* Buto CS functionality enable/disable switch */ \

}

* It is a predefined default structure

* Before the main function it can be used for initialization:
USART _InitAsync_TypeDef UARTO init = USART INITASYNC_DEFAULT;
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Configuration of the UART

" |Interesting difficulty with PEO and PE1 pins
O Check datasheet on page 65.

Uo_RX PF7 PE1 PA4 UARTO Receive input.

UARTO Transmit output. Also used as receive input in half
duplex communication

0 UO_RX and UO_TX default locations are PF7 and PF6,
respectively, that has to be changed since the circuit
(i.e. the board) has been designed for UART
communication at Location 1

Uo_TX PF6 PEOD PA3

e Datasheet is valid for the IC not for the board but a freedom
is given this way for the board designer

O Location 1 has to be set for correct operation

e . Méréstechnika és .
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Configuration of the UART

" Check reference manual at page 492

17.5.22 USARTn_ROUTE - I/O Routing Register
005t |5 (g SE slslez slele|zlo|c]e o o~ [ofo |« |0 oo
Reset E o [=]
Access % % % % %
z z |z |z |z
Name E o (B |w
< x
g 38|82
=
31:11 Reserved To ensure compatibility with future devices, always write bits to 0. More information in Section 2.1 (p. 3)
10:8 LOCATION RW /O Location
Decides the location of the USART /O pins.
Value Mode Description
0 LOCO Location 0
1 LOC1 Location 1
ocauon
3 LOC3 Location 3
4 LOC4 Location 4
5 LOCS Location 5
. Méréstechnika és .
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Configuration of the UART

" Check reference manual at page 492

17.5.22 USARTn_ROUTE - I/O Routing Register
o0st |5 (g% 8|5 |g8|3 |8 s g geslele|z|oe|z|e|o|n|~ow|<|o|a]-]o
Reset 2 o | o o
=
Access % % % % %
= =
o Z =2 | 2
Name E E § E E
g 3|8 2
1 TXPEN 0 RwW TX Pin Enable
When set, the TX/MOSI pin of the USART is enabled
Value Description
0 The U(S)n_TX (MOSI) pin is disabled
1 The U(S)n_TX (MOSI) pin is enabled
0 RXPEN 0 RwW RX Pin Enable
When set, the RX/MISO pin of the USART is enabled.
Value Description
0 The U(S)n_RX (MISO) pin is disabled
1 The U(S)n_RX (MISO) pin is enabled

© BME-MIT
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Configuration of the UART

= Setting the I/O Routing register (i) for LOC1 (PEO
and PE1 pins for UART communication) and
enabling these lines for transmission and
reception of serial data
o UARTO->ROUTE |= (1) << 8;
e Although correct but not too informative

O A definition can be used for this purpose in
efm32gg usart.h (search for ‘LOC1’)

. #define USART ROUTE_LOCATION LOC1
(_USART ROUTE_LOCATION LOC1 << 8)

0 UARTO->ROUTE |= USART ROUTE_LOCATION LOC1:
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Configuration of the UART

= Enabling RX and TX via RXPEN and TXPEN bits
respectively

O A definition can be used for this purpose in

efm32gg usart.h (search for ‘RXPEN’ and ‘TXPEN’)
- UARTO->ROUTE |=(USART_ROUTE_RXPEN | USART_ROUTE_TXPEN):

= Everything is ready for sending data via UART
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Sending data via UART

" |n Project Explorer window under [sfesaegees =5 =20

& prsRxInput(USART TypeDef*, L A
& prsTriggerinput(USART TypeD

emlib->em_usart.c you can find - USARY Baurateheyneset(Us!

0 USART_Tx(USART TypeDef *usart, uint8 t data) :E:ig-:zag:z::;zﬂ”;sf;

@ USART_BaudrateSyncSet(USAF

= Code to be inserted: o USART Enable(USART TypeDe

@ USART_InitAsync(USART _Typel

O USART_TX (UARTO ] e ) - e USART_Initl2s(USART_TypeDef

& USART_InitPrsTrigger(USART_T
@ USART_InitSync(USART_TypeD

0 We send ‘+ signal via UARTO © USART_Reset(USART_TypeDef
® USART_Rx(USART_TypeDef*) :

1 1 1 ® USART_RxDouble(USART_Type

O Good idea to check the compilation s

® USART_RxExt(USART_TypeDef

= Where is the UART (COMx)? o USART_SpiTarser(USART T

o USART_Tx(USART_TypeDef*, ui
e USART_TxDouble(USART Type

O Check in Windows Device Manager o USART TxDoubleExt(USART T

@ USART_TxBxt(USART TypeDef* v
< >
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Sending data via UART

" Check UART (COM port number and its settings) in

Device Manager in Windows (now it is C9M4)

% Device Manager | s
File Action View Help
&= @ B b EEXG

@ Carmneras A
Ld Computer

== Disk drives

B8l Display adapters

= DVD/CD-ROM drives

i Firmware

#r Human Interface Devices

*& |DE ATA/ATAPI controllers

= Keyboards

[ | Memory technology devices

Q Mice and other pointing devices
3 Monitors
P Network adapters

Portable Devices
l v ? Ports (COM & LPT) v
& JLink CDC UART Port (COM4) ]
= Print queues v
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Sending data via UART

= A PC-based terminal program is needed to get
access to COM4 port: an option is putty.exe

R PuTTY Configuration ? X B puTTY Configuration ? X
Category: Category:
Em Basic options for your PuT TY session Q-S_ESSion Options controlling local serial lines
. Logging . i . ~Logging .
& Terminal Spe:_:lfy_l‘he 2 ’UOI"I youwantto connectto 3 = Terminal Selecta senal line f \‘
- Keyboard Senalline Speed - Keyboard Serial line to connect to |co|\,q4 |
- Bell coms 115200 ] - Bell
- Features i - Features Configure the serial line
= Window ’ : . =-Window
. Appearance {JRaw () Telnet () Rlogin OSS)—'_ (@) Serial - Appearance Speed (baud) |‘I‘IBZDD |
- Behaviour Load. save or delete a stored session 1 ~Behaviour Data bits |3 |
- Translation s d Sessi - Translation
[-Selection aved -essions [ Selection s |'I |
- Colours | | - Colours Parity N
. ari one L
&= Connection Default Settings Load | Sae on
- Data —] -~ Data Flow control None ~
- Proxy - - Proxy
- Telnet - Telnet ‘
- Rlagin Delete - Rlogin \ 5 y
= [+-SSH
. Serial T - Serial

Close window on exit:
() Always () Never (@) Only on clean exit

About Help Cancel About Help I Open Il Cancel

6
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Sending data via UART

"= The terminal is now open

= Compile and download the code to check
operation

O Has the ‘+’ sign appeared in the terminal window?

Ef COM4 - PUTTY — ] X
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Sending data via UART

= This status is the starting point to develop an
UART communication-based application

O E.g. write in the terminal window the character
pushed (= read a character from UARTO and send this
character to UARTO)

 This function has to be added into the program (in the while
loop)

» USART_Tx(UARTO, USART_Rx(UARTO));
O Problem: character is received in a blocking way:

 We are always in the loop waiting for data and no other
operation can be done

e Better if the arrival of new data can be indicated not to stack
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Appendix:program code(a working version)

R
[

#include "em device.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em chip.h"

=1 o LN o= L

USART T nitAsync_TypeDe f URRT U_init=USART_INI TASYNC DEFRULT;

3o

~int main(void)

10 1

11 /* Chip errata */

12 CHIP Init();

13

14  CMU->HFPERCLKENO |= CMU_HFPERCLKENO_GPIO;

16 //CMU ClockEnable (CMU Clock TypeDef clock, bool enable)

17 Cmu:plockEnable(cmuCIock_UARTO,true);

//GPIO PinModeSet

( GPIO Port TypeDef port,unsigned int pin,GPIO Mode TypeDef mode,unsigned int out)
21 GPIO_PinModeSet

gpioPortF, 7, gpioModePushPull,1); //EN

— e e

22 GPIO_PinModeSet (gpioPortE, 0, gpioModePushPull, 1) ; //Tx
23 GPIO_PinModeSet (gpioPortE, 1, gpioModelInput,1); //Rx

24

25 USART InitAsync(UARTO0, &UARRTO init):

26

27 URRTO->ROUTE |= (1) << 8;

28 URRTO->ROUTE |= [USART_ROUTE_RXPEN | USART_ROUTE_TXPEN];
29

30 //USART Tx (USRART TypeDef *usart, uint8 t data)

31 USPART_TR(UARTD, "+,

32

33 /* Infinite loop */

34 while (1) {

35 USBR'I‘_'I‘K(UBRTD, USBR'I‘_RK(UBRTD}];

36 }

37
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